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UPDATED ASCENDER - Next Year Payroll
Process

Created: 03/09/2018
Reviewed: DRAFT
Revised: DRAFT

The purpose of this document is to guide you through the necessary steps to create next year's
payroll. This process includes updating tables and employee information, calculating salaries,
performing edits, and interfacing payroll to Budget. This process occurs in the next year and does
not interfere with the current year processing.

This document assumes you are familiar with the basic features of the ASCENDER Business system
and have reviewed the ASCENDER Business Overview guide.

| Some of the images and/or examples provided in this document are for informational
& » purposes only and may not completely represent your LEA’s process.

Prerequisites

Prerequisites:

Gather Beneficial Data:

6 This section is strictly for informational purposes.

Before performing the next year payroll process, review the following tables and gather the data that
will be beneficial while you are updating this information for the new school year.

Proposed/Approved Next Year Salary Schedule

Personnel > Tables > Salaries
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Once a salary table is assigned to an employee on the Payroll > Maintenance > Staff Job/Pay Data >
Job Info tab, the table can be updated and salary calculations can be run for all affected employees
eliminating the need to update the information for each individual employee.

Proposed/Approved Next Year Workday Calendars

Personnel > Tables > Workday Calendars > School Calendar

After receiving the upcoming approved school year calendars, you can create a calendar(s) to assist
with documenting employee workdays and holidays. It is helpful to plan future pay dates and payoff
dates for the next school year in advance.

Reference State Minimum Salary Schedule

Review the TEA Minimum Salary Schedules for changes effective with the new school year.

Accrual Calendar Information

Payroll > Tables > Accrual Calendars > Accrual Calendar

O Creating and assigning an accrual calendar to employees allows you to maintain the accrual
calculations throughout the school year. You can obtain workdays by month information from the
workday calendars.

O Be sure to keep the same accrual codes for each accrual calendar. This method allows for
consistency and eliminates the need to update the information for each individual employee.

O Accounting for the August EQY accrued days in the accrual calendar and using the EQY Payroll
Accruals process assists in properly accounting for accruals across the fiscal years.

Update Next Year Staffing Changes

When payroll opens for the next year, be sure to keep up with the following staffing updates:

¢ Resignations and new hires: Update the employee status as resignations and new hires are
approved to allow the appropriate budget amounts to be created and interfaced.
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o Review TSDS Best Practices for New Employee Records.
o Review TSDS Best Practices for Terminated Employee Records.

e Campus level changes: Update the job table and employment information as jobs move from
one campus to another.

e Distribution changes: Update employee distributions based on budget changes.

* Update extra duty/stipend pay: Update the extra duty table to reflect changes and
payments. Also, update the balance on the Payroll > Maintenance > Staff Job/Pay Data > Pay
Info tab. The next year payroll budget calculations use the s-type extra duty remaining amount;
therefore, it is important to verify that these amounts have been updated.

¢ Update substitute pay: If substitute pay rates change, update the Personnel > Tables >
Salaries > Substitute tab, which is associated with entering employee substitute leave
transmittals.

Extract Third Party Administrator (benefits) Information

Payroll > Utilities > Employee Benefits Interface > Extract

Perform an extract to create the files containing deductions and demographic data to be sent to the
third-party vendor.

Only deduction codes that have an Extract Ded Cd (extract deduction code) on the Payroll > Tables
> Tax/Deduction > Deduction Code are extracted.

After the new premiums are updated by the third-party administrator and the file is returned, you can
import the updated file making the changes to the next year deductions in one step.

Payroll > Utilities > Employee Benefits Interface > Import Annual File

This utility imports the next year employee benefit choices via a file created by your third-party
vendor. Importing data decreases the amount of time it takes to enter individual employee data
changes.

Manage Employee Change Requests

O Create a form for next year employee change requests. This form assists with data entry and
provides documentation.

O Set a deadline for employee change requests prior to the end of the current school year to allow
time for clarification if needed.

O Update employee direct deposit information. Use caution when updating this information in the
next year frequency as the system will prompt you to update this information in the current year
frequency.
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O If your LEA has not already done so, set up the EmployeePortal application. EmployeePortal allows
employees to submit demographic changes and payroll (W-4 and direct deposit) changes. LEA-defined
options determine what changes can be made by the employee and the necessary approvals.

Before You Begin

Before you begin:
Things to Remember Prior to Beginning NYR Payroll

O Ensure open communication exists between the payroll office and business office.

e Verify that the Budget process is complete and the budget is open.
¢ Set potential deadlines for various presentations.

[ Verify that you are logged on to the current pay frequency.

0 Remember: Next year calculations and distributions are validated to the new budget (N). Make
sure that the fiscal year on the distribution pages matches what is in the new budget (N). If it changes
during the process, perform a mass update.

Current and Next Year Shared Pages

The following pages are shared between the current year and next year. Use Caution
when updating these pages in the next year:

Personnel or Payroll > Tables > District HR Options
Personnel > Tables > Credential

Payroll > Tables > Tax/Deductions

Payroll > Tables > Bank Codes

Personnel > Maintenance > Staff Demo (all tabs)
Personnel > Maintenance > Employment Info

Reminders

e New employees must have a Unique ID. Create a Personnel record and copy it to NY Payroll to
ensure that they are included in the Unique ID Extract.

¢ Do not update years of service or leave until Service Records have been created. This usually
occurs between the June and July payrolls and is covered in the Service Record guide.

e Medicare On-Behalf is usually posted to the TRS website in late summer. In most cases, a
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reminder is sent by your ESC so you can book actuals to Finance for the year and create a
budget for next year.

e Remember to update NY Payroll in Budget periodically to ensure that changes are updated. This
allows Budget to remain as current as possible.

Extract IDs

Extract IDs can be used to group similar employees to allow for easier and more accurate mass
updates. For example, most 187-day teachers/aides have the same contract Begin and End Dates,
same Calendar Code, and the same Payoff Date, which may allow them to be grouped together by
extract ID making it easier to select that group of employees when performing Mass Updates.

To use extract IDs:
Personnel > Tables > Job/Contract > Extract ID

O Add or modify extract IDs.

JOB CODES CONTRACT CLASS CONTRACT TERM CONTRALT YEAR EXTRACT ID TERMINATION REASON

Delete Extract id Extract id Desription
® | A | 187 TEACHERS/AIDES |
B [ 8 ] [202coacHes |
@ [ c ] [207 counseLor/TECH |
[ D ]| [182 caFeTERIA ]
(I £ | (226 EMPLOYEES ]
[ F ] 256 MAINTENANCE ]
@ [ ¢ ) (22050 SECRETARY |
3 [ ") [1merrEs |
@ T I ] [177 PTcusTODIAN ]
=) &= )

I l These extract IDs must meet your LEA's criteria so it is important for the Payroll and
&9 Personnel departments to communicate about the setup and use of extract IDs.

Personnel > Maintenance > Employment Info
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O After extract IDs are established, assign or modify the extract IDs for each individual employee

record.

Employes Status: | 1 Active professional  +

Pt Day Employed Effective Date: (5555 5550 |

Employment Dates

Ovgea np Dot

Latest Ra-Employ Oute

ey Do

Extract for TSDS: D

Terminatsan Reason I:I
Eligibile for Ri-hine: O

Percent Day Employed: 100%

Retricve ] l Directory

Employed

Employment Types Retires Infonmation

Employmient Type: [; Hakf-Tire or ‘\’ Retirement Date:

Sub Type: [ v; Retiree Employment Type: | =
Highly Qualifipd 0O Take Rotires Surcharge: ]

Year Round: D NY Take Retires Surchange: D

Eatract IO 02 TEACHERS 10MONTH

Payroll > Utilities > Mass Update

O After extract IDs are assigned as needed, select the applicable Extract ID and run the necessary
mass update for a specified group of employees. Extract IDs can also assist in sorting and filtering

report data.

DEDUCTIONS  LEAVE EMPLOYEE EXTRADUTY  JOB CODE

Rt

(] Pay Ststan e o) tner Py Suep

[ Pt Youe 1 [ Catendar

(] ek Fane T | () Comeract Begin Dats
[ wesreserymrnt Elig = | [f] Conaract End Duts
O Prw-ticee ~ | [f] Mt Days Emmpled

PSP Stalf Salary Datal
[ meatth trs Cocde

(] #5P Sratt Daka Code
D TS Mirnba Pod

[[] # of Mewatvs in Contrace
=[] Contract Days
v | [ Locst Contrct Davs

|
Fayedl Date
[Murmber of| [ Pay Grase
() Aol Pyt L 28 [ wocat Setvivie
(] Aemnaining Payments . Nl
() WE A Puyments mE

() WE Remainieg Puymans LB [0 Wiy g ek

Py Statunc
W Acteer () Inactive () Both Fromary Camgr
Fay Campus:

Py Type: | &0 -] Contruct Bagin Duts
o Coce: M v Cortrat End Dute: |
Aogualtede Al v Contract Wonths:
ST —
e 1 D

| Pt I
i N
o S —
[ ] e [F Mostity NYR u-;!
i 4 L
L ~|  Salary Concept: | i |
1 »
I | [T [0z TEACHERS 10manT | |
:] Emplores Wb i
SALARY CALOULATION
Incremens 3“‘.{.. [ Emecute
Y - ) Py e From T
- ) i [ 1 Cosaract Begen Dube .. |1 =
06-03- 2026 [ Suvte Snen Contract End Dabe: [ | [ ]
05-23-2027] ) i 20 R — [ CHE G|

= ] Totst ot Experience

L
—
foe-z3-2023)

0 DOy

— — —

—_— B Emploprrens Dista « |

Conract Days 000 TRS - 000 TRS - ]
Payodt Date: | 11 ]

M

Personnel > Reports > User Created Reports

If your LEA uses extract IDs to group employees for mass updates, generate a user-created report to
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verify that extract IDs are correctly assigned to employees.

If extract IDs are missing or need to be changed, you can manually update individual employee
records using the Personnel > Maintenance > Employment Info page.

Next Year Payroll Process

In Payroll > Current Pay Frequency:
1. Verify August EQY payroll accruals.
Verify August EOY payroll accruals
This step applies to LEAs that included non-accrued employees in the EQY payroll accrual

process.

O If ASCENDER is used for the EQY payroll accruals, verify that the accrual reversal process was
completed in September 2025.

Log on to Finance file ID 5.

File ID: 5

Finance > Inquiry > General Ledger Inquiry > General Ledger Inquiry
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Aount P 8
Fund  Func Oty Sobi Org B = '+ LTS LT RE PP J ’ 1
Retrieve | Reset |
. : H H H H H H H : | | )
Account Code: (199 J§ (12 J8 (o0 Ji|Goc )i (oo ) # () # ()F () - L .
Dt P Dtz T e for
Crity Dist: = Pogo: ol 65
Processed B Cument (08) B Mest (08) B 190 11 G130 X000 X K00 K 0l Fiko I0x &
st R [RLz s
Type Mumibor Disbe Poxr i Appaopristicn Es Balaros
TG 11 EME 00 001 5 11 Q00 BALARY
** Ereginning 000 Q.00 00 0oy
GJ  MWBEU  00401-2024 09 OPFEMING ENTRY -56,504.00 000
GJ PEOE1E 0B-13-2024 09 SEP- PAYROLL DISTRIBUTION 4,589
Gl PE101S 10152024 10 OCT - PAYROLL DISTRIBUTION 4 365 89
Gl PEINE 1182024 11 ROV - PAYROLL DISTRIBUTION 4,065 80
G P13 12133024 12 DEC - PAYROLL DISTRIBUTION 436585
Gl PRS0 1525 01 JAN - PATROLL DISTRIBUTION 40418
GJ PEIZN 02-14-2025 02 FEB- PAYROLL DISTRIBLUTION 438588
Gl PE03T4 03-14-2025 03 MAR - PAYROLL DISTRIBLITEON 4 265 50
Gl PEOMTS 04162025 04 APR- PAYROLL DISTRIBUTION 406588
GJ PEOSI5S 0515225 05 MAY . PATROLL DISTRIBUTION 4,365 90
Gl PEOS1Y 06122025 06 JUM- PAYROLL DISTRIBUTION 4,365 88
Gl PEOT1S OFIRAES 07 JUL- PAYROLL DISTRIBUTION 461589
[<9] PECE1S 08152025 08 ALG - PAYROLL DISTRIBUTION 411562
I G EOYACT 08-31-2025 08 ALKG PAYROLL ACCRLU DISTRIBLITI 454072 |
** Ending -56, 50400 000 5845744 -146 56

o Type 199.11.6119 or 199.00.2161 in the Fund, Function, and Object Code fields.

o Leave all other fields masked (Xs).

o Click Retrieve.

o Verify that “Payroll Accrual” (or an LEA-defined description) with a positive expenditure
amount was posted (typically in August 2025).

Log on to Finance file ID C.

File ID: C

Finance > Inquiry > General Ledger Inquiry > General Ledger Inquiry
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GEMNERAL LEDGER INQUIRY GEMERAL LEDGER ACCOUNT SUMMARY EMPLOYEE DISTRIBUTION LIST INQUIRY  OVER EXPENDED ACCOUNT SUMMARY

m Processed m Curment Pericd: 09 m Maxt Period: 10 m includae soft encumbrances whan POs exist D Exclude Objects 61XX U Include Inactive Accounts|
Description
Show Datails  Report will display Transaction Detals ’
ORemon @\ .
Fumng Fung Oy Soby Org Frog

Account Code 1- ! E E ! DE 5 [a! ! l Fatriews I[ Faset ]

29 T
Date Run: Detall Traraactons for Expendituns ACCounts
Cinty Dist: 150 Pageclod 4
Frocessed [ Curent (08) B Newt (10) B 195 11 6115 00 000 X X N N File ID: C
Ext Revanus' Rizd Rmvenos
Typs Number Dot Par FesascnDeacription Appropriation Encumbrances Expsndturs Balarce

159 11 611500 001 4 11 0 00  SALARES TEACHERPROFESSIONALS
= Beginning 000 000 0 000

ol LR L 00 CioEMiar BRI Sas B0 N0 Iilhdl

| &/ REVACC 0905214 99 AUGPAYROLL ACCRU DISTRIBUTI 8175037 |
[cA g i = i yi 1R
Gl Ps0n0 W OCT . PAYROLL DISTRIBUTION 74005 27
“ Ending 255,852 00 000 5550006 S5 54

o Type 199.11.6119 or 199.00.2161 in the Fund, Function, and Object Code fields.

o Leave all other fields masked (Xs).

o Click Retrieve.

o Verify that “August Payroll Accru” (or an LEA-defined description) reversal entry with a
negative expenditure amount was posted (typically in September 2025).

O If ASCENDER is not used for the EQY payroll accruals (days worked in August), there is no
computer journal entry. Verify that the manual JV entries were posted for EQY payroll accruals.

O If a reversal entry is not displayed, use the Payroll > Payroll Processing > EOY Payroll
Accruals page to complete the process.

Year: C Frequency: &

ACCRUAL TABLE DECREMENT RUN CALCULATIONS ACCRUAL REPORTS CREATE GEMERAL JOURMAL INTERFACE TO FINANCE POST TO MASTER REVERSAL FOR NON-ACCRUAL MASS DELETE

Fila iDx Ruaversal interface Transaction Date:
Accounting Period
y NNt

(®) Post to Curren

1) Prost to Mo &

Select  Freoyency  Caloulation Date  Create ) Date  interfaceDate  PostedDate  Bewersalinterface Date
D F 08-31-2024 05 26- 2024 05262024 09-10-2024
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2. Clear next year tables.
Clear next year tables
Log on to the current pay frequency.

Payroll > Next Year > Copy CYR Tables to NYR > Clear Next Year Tables

CLEAR NEXT YEAR TABLES COPY CURRENT YEAR TABLES

|:] Clear EQY Accrual Data Only E] Clear NY Payroll Budget Only

Mo Rows Accrual Calendar [_ Execute
Extra Duty Pay

Haourly / Daily Salary

Job Code

Local Annual Salary

Midpoint Salary

School Calendar

State Minimum Salary

Substitute Salary

Whorkers' Compensation Rates

Employee Bank Record
Employee Deductions

Employee Extra Duty
Employee Job

Employee Pay

AN AN |
| N \_‘_,J

Joooocoogogooopooooo

Employee Pay Distribution
EQY Accrual Calendar

EQY Accrual Data

EOY Accrual Fund Decrement

NY Payroll Budget

If the next year payroll process was used last year and those records were not cleared, use the
following steps to clear the records.

0 Do not select the Clear EOY Accrual Data Only and Clear NY Payroll Budget Only
fields. The EQY accrual data and next year payroll budget data is cleared whether or not these
fields are selected.

O Move all of the tables from the left side to the right side of the page.

 Click Execute.

Notes:

o This process deletes all existing employees from the next year payroll files and a
clean work file is now available allowing you to begin building next year data. In
addition, all tables in all pay frequencies are cleared; therefore, it is only necessary to
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perform this process in one pay frequency even if your LEA has multiple pay
frequencies.

o This process can be verified by running the Personnel > Reports > Personnel Reports
> HRS1000 - Roster of Personnel Report for both active and inactive employees with
the next year frequency. The report results should be blank.

3. Copy current year tables.
Copy current year tables
Log on to the current pay frequency.

Payroll > Next Year > Copy CYR Tables to NYR > Copy Current Year Tables

CLEAR NEXT YEAR TABLES COPY CURRENT YEAR TABLES

E e Select All Tables
Accrual Calendar I g ] [. = = ]

Extra Duty Pay

Hourly / Daily Salary

Job Code

Midpoint Salary

School Calendar

State Minimum Salary

Substitute Salary

l
[
(
(
Local Annual Salary |
[
[
|
|
l

_,__,_____,__
(N IS IS R O N Y S IR N (Y CS B S T N

Workers' Compensation Rates

O Click Select All Tables to select all current year tables to be copied to the next year. It is
recommended that all tables are copied so that you have immediate access to any selected
table.

o This process copies all tables (except the school calendar table) for all next year pay
frequencies, regardless of the pay frequency to which you are logged on.

o To copy the school calendar, log on to each pay frequency to do so. The school calendar
is not copied, only the calendar code and the calendar description are copied.

O Click Execute. A separate preview report is displayed for each selected table.

O Click Process on each report page to copy the table. Or, click Cancel not to copy the table. A
message is displayed indicating that the tables were successfully copied. Click OK.

4. Copy current year staff to next year.
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Copy current year staff to next year
Log on to the current pay frequency.

Payroll > Next Year > Copy CYR Staff to NYR

i 1 | Rese ] | t
Parameters
Pay Status
| @® Active (O inactive (O Both | Primary Campus: [ v | Payoff Date: ‘:]E
Pay Campus: [ Au M ] Frequency: (6 MONTHLY CYR " ]
Ipdf Type: [ E Exclude Substitute v ]I Contract Begin Date: | v]  Satary Cancspt (A1l v)
L A T - 4 L
Job Code: AlL | Contract End Date: [ £ | Extract 1D T I
Accrual Code: All "I Contract Months [:] Employee Mbr S’
Prior Yr Emp Date: | 00-00-0000
Options
| Il';lL-fJ-.- Employess with Termination Date I
U Inactivate Records when Creating WY Tables
D Praview changes
Mext Year's Funding Code D
MNumber of RBemaining Deductions [:]

Copy the employees from the current year payroll to the next year payroll. If you have multiple
pay frequencies, complete this task in all pay frequencies.

Reminder: Be aware of where the budget is in terms of the fiscal year.

What happens?

A complete copy of the current employee record is moved to the next year. Employees can be
inactivated or activated when copying to the next year and those with termination dates can
also be included in the copy process. When copying, you can change the fiscal year in
distribution as well as the remaining deductions in the employee master record. If you update
the number of remaining deductions, all deductions on the employee Deduction tab are
updated to the designated default value. Be careful of deductions that should not be activated
for the next year and those that the number of remaining deductions should be different from
the default value and perform any necessary cleanup. The Payroll > Utilities > Mass Update
tabs can be used to modify remaining payments for deduction codes.

If this process is performed multiple times for employees without deleting their NYR records, the
system either updates or inserts distribution records from CYR to NYR and cleanup may be
necessary.

Employees in the next year must be active to extract distribution information to Budget. If you
do not activate employees when copying to next year, you can activate them when you perform
a mass update.

O Under Pay Status, select Active to copy only active employees.
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O In the Pay Type field, select E Exclude Substitute.
O Under Options:

o It is recommended to select Include Employees with Termination Date to copy active
employees with a termination date on the Personnel > Maintenance > Employment Info
tab.

o Do not select Inactivate Records when Creating NY Tables.

o In the Next Year's Funding Code field, type the fiscal year to be used when updating
the distribution account code fiscal year in the next year employee master distribution
records.

Leave blank if the distribution account code fiscal year in the next year employee master
distribution record is to remain the same as the current fiscal year until the next year
budget is in place. Then, use the Mass Update utility to update to the correct fiscal year.

o |t is recommended that the Number of Remaining Deductions is left blank to copy
deductions with the number of remaining deductions as they exist in the current pay
frequency.

O Click Execute. If the process is successful, a preview report is displayed. Review the
employee list to verify that the correct data was copied to the next year records. Also, review
the total employee count at the end of the report.

O Click Process to accept the changes and continue. A message is displayed indicating that
the process was completed successfully. In addition, a list of the database record tables that
were copied is displayed. Click OK.

O Click Cancel to return to the Copy CYR Staff to NYR page without making the changes.

F
i

- Prior to continuing this process, log on to the next year pay frequency.

In Payroll > Next Year Pay Frequency:
1. Update TRS rates table.
Update tax/deductions
Log on to the next year pay frequency.
Payroll > Tables > Tax/Deductions > FICA Tax

Retrieve the FICA rates for the 2026 calendar year and print a copy for reference. Then, retrieve
the 2027 calendar year record and manually enter the 2026 rates for 2027 and click Save.

0 CAUTION: Be sure to retrieve the 2027 year record prior to updating this tab.
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catondervaar: (026 )| [ review | [

EXEMPTIONS  INCOME TAX UNEMPLOYMENT  TRSRATES ~ ANNUITY RATES  WORKERS COMP  DEDUCTION CD

| Pring

FICA Max Salary:

Emplayes FICA fate [ 620% Employes FICA Max Tax: 11.239.00

Emplover FICA Rase [ 520%] Employes FCA Max Tax 11.439.00

Modicare Rate: Additional Medscane Rate: MAdditional Medicare Salary Threshaold:

HEA Max Employis Contribution

lmmmr. I Retrievs ]I Dolet _J
EXEMPTIONS  INCOME TAX UNEMPLOYMENT ~ TRERATES  ANNUMYRATES  WORKERS' COMP  DEDUCTION CD
| |

Payroll > Tables > Tax/Deductions > Unemployment

If your LEA allows ASCENDER to calculate unemployment, select T - Taxable in the Employer
Type field and enter the Unemployment Rate. Type the percent rate determined or assigned by
the TWC (e.g., 0.4985% for 0.004985).

The rates displayed in the below image are sample rates. Only use the rates provided by the
Texas Workforce Commission (TWC).

EXEMPTIONS INCOME TAX [FICA TX UNEMPLOYMENT THS RATES ANKUITY RATES WORKERS' COMP DEDUCTION CD

Prinst

Payroll > Tables > Tax/Deductions > TRS Rates

Update the TRS rates.

6 CAUTION: Be sure to retrieve the 2027 data prior to updating this tab.
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IMPORTANT: Be sure to visit the following TRS websites:
https://www.trs.texas.gov/Pages/re_contribution_rates.aspx and

& https://www.trs.texas.gov/Pages/re_salary _cap_provision.aspx to obtain the
updated rates for the next school year, and then return to this table to update the
new rates.

Note: The below image displays the TRS rates for the 2025-2026 calendar year. This image
will be updated to reflect the TRS rates for the 2026-2027 calendar year as soon as they
are published.

School Year: | 1037

EXEMPTIONS INCOME TAX FICA TAX UNEMPLOVMENT TRS RATES

CAUTION: Be sure to type the new
school year and click Retrieve

before entering the updated rates.
!

TRE Rate Masnbios Ritisgamenl Contiduatica W
TRS ndurance Membor Carg Contribution [ 0.65%) Emplayer Paid M|
District Rate S Contribution B.250%)]
TRS Care Rate Fodoral TRS Care: ( 1.25%)
TRS Care Empls Contrib RE TRS Care Cantribution [ orw
TRS 5 Satary Cap [ 300009

THRS Neon-OASDI Rate  Public Education Employer Contribution (PEEC) 2.000%]

O To create a new TRS rates record, type the new year (2027) and click Retrieve. A message is
displayed indicating that the new record is populated based on the prior year's (2026) TRS rates
record, click Save to retain the record.

O Complete the applicable fields. This information is used when performing calculations and
extracts to Budget.

Payroll > Tables > Tax/Deductions > Deduction Code
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] Year: T
EXEMPTIONS INCOME Tax FICA TAX UNEMPLOYMENT THS RATES AMMUITY RATES WORKERS COMP DEDUCTION €D
Detete  [Deduction Code L Deserigtan Wite Vendat MameDart Key Vendor Mo Extract Ded Gl W] Heglth Care
] [ADDmONAL WITHHOLDING Tax._ | [v DD SO O { | | | [ | d
. [urarmeD wea | [UFunted ~] [UnmEDWAY ] m] O | o ) O
(] [GavinGS BONDS ] [58Saving ] [(SavinGs BONDS | (] O [ || | O

O Update the deduction codes. The Deduction Code tab is shared between the current year and
next year records; therefore, changes to the current year records are effective in the next year
records, and vice versa.

2. Update job code table.
Update job code table
Personnel > Tables > Job/Contract NYR > Job Codes
Add or update job codes as needed.

The job codes table is NOT shared between the current year and next year records.

s J
JOB CODES
Delete  Job Code lob Description EEOC Code Accournt Coge Salary Conceot Increa:
) [ oooo | [ceneric D v [ - | 3 [Auseasnnual satary table  +|
[0001 ] [HIGH SCHOOL TEACHER ][ w] [-- .- ---- ] 3 [AUseannualsalary table ]
[ o002 ] [TEACHER/COACH i v [ - ] 3 [AUseannualsalarytable v

O Select the appropriate Salary Concept for each job.

O (Optional) Update the distribution Account Code fields.

Notes:

o In the FTE Hrs field, type the appropriate full-time hours for each job code. Effective
September 2017, the scheduled weekly hours are used by TRS reporting.

o You can assign accrual codes, Workers’” Comp codes, and FTE hours to lessen the
workload when completing tabs for new employees.
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3. Reports > User Created Reports: Ensure Extract IDs are correctly assigned to employees. If IDs
are missing or need to be changed, make changes by employee at Personnel > Maintenance >
Employment Info tab

4. Mass update deductions.

(If applicable) Mass update employer contribution and remaining
payments

Log on to the next year pay frequency.

Use the Mass Update utility to update employee data in preparation for the new school year.
This utility allows you to quickly and easily mass change data resulting in minimal manual
changes to individual employee records with less possibility of manual entry errors.

pay frequency to which you are logged on as you may be changing back and forth

0 CAUTION: To avoid entering data in an incorrect pay frequency, be mindful of the
between the current year and next year's pay frequencies for several months.

If applicable, mass update the Employer Contribution and Remaining Payments for all
employees with health care and other employer paid deductions.

It is recommended to update the number of remaining payments for deductions to ensure
they are fully budgeted for.

Payroll > Utilities > Mass Update > Deductions

This utility is used to update deductions for a number of employees at a single time.
Deduction data may be updated by a variety of criteria including pay type, pay grade,
primary campus, and pay frequency. The Deductions tab allows users to add, change, and
delete deduction codes as well as alter the number of remaining payments and the existing
dollar amounts associated with the deductions. Mass deduction updates are very useful at
the beginning of the year when many employees are being added to insurance programs.
Once deductions are added using this tab, they are reflected in the individual deduction
records.
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O Under Parameters, select the employees whose deduction data is to be changed.

TIP: Prior to processing a mass update, capture a screenshot of the parameters used for future
reference.

O Under Method, select the type of deduction change to be implemented.

O Click Execute. A preview report is displayed. Review the report.

O Click Process to accept the changes and continue. Or, click Cancel to return to the Mass
Update page.

5. Mass update pay and state steps

1. Verify staff data.
Generate reports to verify employee data
Log on to the current pay frequency.
Generate the following reports to assist in verifying employee data.
o Personnel > Reports > Personnel Reports > HRS1000 - Roster of Personnel - If an

employee was not copied over to the next year, run the Copy CYR Staff to NYR utility
again for only the single employee.
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[ Preview ] [- PDF ] { csv ] [ Clear Options ]
Personnel Reports HRS1000 - Roster of Personnel
HRES1000 - Roster of Personnsl - <
H_::+L0.10_E_ ] ] ;W‘rﬁ‘ port Parameter Description Value
HRS1200 - Federal EEOC Report -
HRS1250 - Employee Data Listing Sort by Alpha (A). Pay Campus (C), Primary Campus (P)
HRS1400 - Tescher Service Racord Print Address Primary (P), Alternate (&)
HES1450 - Emploves Mailing Labels
HRS1500 - Emploves Education Regort Select Restriction Local (L), Public (), or Mo restrictions (N) (N ]
HRS1550 - New Hire Report 5
HR51600 - Cerification Report Include Primary Job Code? (Y/N)
HRS1650 - Employes Salary Information 2
HRS1700 - Social Secyrity Nymber Verification Pay Status Active |A), Inactive {I). or blank for ALL [:
HES1750 - Teacher Incentive Allotment Designation Report Pay Type 1-4, Exclude Subs (E), or blank for ALL :
Eelect Pay Campus(es), or blank for ALL [: i
Select Primary Campusies), or blank for ALL :] 3
Seleet Extract ID{z). or blank for ALL : :
Select Employee(s), or blank for ALL : H
Setect Frequency RN
Date Run: Personnal Roster Report Program: HRS1000
Cnity Dist: I1SD Page: 10of an
Frequency: F
Emp Nbr Employee Nama Employee Address City, State, Zip Primary Campus Telaphone
Job Code
00DOOR  ACHIMON, AARON ROXANNE 36911 CR412 Alama City, TX 25457 107 - 107 Schodl (555) 586-0643
0178 - WWE REG ED TEACHER
000025 ALFORD, ADRIENNE JOHN 25263 BASTROP STREET Alama City. TX 28178 007 - 007 Schodl
0080 - MHS CTE TEACHER
000040 AMOS, ALEXANDRIA M 124578 FM 381 Alamao City. TX 27968 905 - 905 Schod (555) 586-1933
(0662 - EXEC DIR OF OPERATIONS

o Payroll or Personnel > Reports > Personnel Reports > HR51250 - Employee Data Listing -
This report can be used to verify deduction information and is available in Personnel or
Payroll. Run the report with only the Include Reports parameter set to Deductions. A
user created report can be created to only include deduction information. It can be sorted
by deduction code and remaining payments.
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[ Preview ] [ PDF I | csv | Clear Options I
Personnel Reports HRS1250 - Employee Data Listing
HRS1100 - Employves Verification Report
HES1250 - Employee Data Listing '
BS1650 - Emploves S ; Parameter Description Value
Sorty Alha (8 Poy Campus (. Primary Compus 71 [ )
e Reports Setc Fom Lt :
Include SSN on Report? [Y/M) [r l
Include Number of Days Employed /in Contract on Report? (YN) 1 S
From Last Name |3 letters) l D Personnel
To Last Name (3 Letters) 8 Payroll
Job
Pay Status Active (4). Inactive (1), or blank for ALL l D TRS
Pay Type 1-4, or blank for ALL [j Calendar ¥TD
Select Pay Campus(es), or blank for ALL ( [0 sehoot Y70
D Leave
Select Primary Campus(es). or blank for ALL Deduction
Select Extract ID(s). or blank for ALL [ (] Distribution
Select Employee(s), or blank for ALL ( 8 :::'m“‘"b'l""'
E-mail Subject [
E-mail Message
l 0K ‘ I Cancel
From Pay Date (MMDDYYYY), or blank for ALL C
To Pay Date (MMDDYYYY), or blank for ALL 1 |
h"\lj 4 P |
Date Run: Employee Data Listing Program: HRS1250
Cnty Dist: ISD Page: 1of 1
Frequency. F
Emp Nbr: 000006  Emp Name: ACHIMON, AARON ROXANNE PEBLEY
Payroll Name & Primary Address Former Name & Alternate Address Primary Campus: 107 - 107 Scheool
Last  ACHIMON Last Payroll Campus: 107 - 107 Scheol
First:  AARON First: Info Restrict A Gender: F - Female
Middle: ROXANNE PEBLEY Middle Rastrict Public:. A Marital Stat: M - Married
Title Gen: Title: Gen: Local Area 1 Birth Date:  07-12-1360
Street: 36911CR412 Street Local Area 2 LastChg:  03-13-201%
City/St: Alamo City, TX City/St Drivers Lics: 93658985 T™®
ZipCd: 25497 ZpCd DL Expir Date: Deceased: N
Country. TRS Beg. Dt 11-01-2000 SSN 256-66-3799
Phone: (555)586-0643 Cell ( ) BusPh () Bus BExt Citizen: ¥
\wk E-mail: Hm E-mail Hispanic/Latino [ Black/African American O
Supplemental Acgess Asian (] Amenican Indian/Alaskan Native [
OB hite B Native Hawaian Other Pacific sl )
Emergency Contact Relation Bilingual
Phone: Ext
Emergency Notes
Deductions
Emplr  Remain Cafe Emplr TEA
Deduction Code Net Amount Contib  Pymts Refund 125 Factor Factor
001 - ADDITIONAL 300.00 00 99 N N 1 1
025 - ACTIVE CARE PRIMARY 00 51400 99 N Y 1 1
054 - GROUP (DISTRICT PAID 00 & 9 N N 1 1
100 - TPA EXTRACT FILE 00 00 0 N N 1 1

o Payroll or Personnel > Reports > Personnel Reports > HRS1100 - Employee Verification
Report - This report provides detailed employee data such as employment dates, salary,
address, and other information for reference or to verify recent input and processing.
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’ Preview ] ’ PDF ] ’ [Ty ] ’ Clear Oplions ]
Personnel Reports HRS1100 - Employes Verification Report:
HES1100 - Employes Verilication Report
HES1250 - Employes Dalta Listing dat
HRS1650 - Emgloyee Salary Infommation Parameter Description Valle
Sort by Alghs (), Pay Camus €. riasy Cams )
Select Restriction Local (L), Public (P), or No restrictions. (N)
Primiary Jot (), or ik for AL )
Pay Status Active (&), Inactive (1), or blank for ALL
Pay Type 1-4, Exclude Subs [E), or blank for SLL
Salect Pay Carmpus|es), er blank lor ALL 1
Select Primary Campusies), or blank for ALL :} i
Seect Extract Dfe,ox bank for ALL 1 :
Select Employes(s), er blank for ALL A
Date Run: Employes Verificalion Report Program: HRS1100
Gty Dist: 1SD Page:3of 9
Frequency: &
Emp Nbr  Employee Name Emp Date Emp Status Pay Status Job Code
Sex Address Term Date  Term Reason Cred Yr Svc Pay Campus Primary Campus
City State Zip Pro Yrs Exp MNon-Pro Yrs Exp ExtLvBeg  Payoff Date “%Day Empl St Step GRDILVL /Sched
Birth Date Telephone In Dist In Dist Ext Lv End TRS Beg Date  Annual Sal Pay Type Pay Rate
000060 SMITH, BARBARA GALE 08-16-2001 2 - Active auxillary per 1 = Active 0428 - PHYSICAL EDUCATION
F PO BOX 555 (m] 999 - District Wide 735 - CAFETERIA
ANYWHERE TX 78899 (1]} 14 08-25-2022 100% SPA / 114
03-01-1962 o 14 03-01-2009 33,702.00 2 2,808.50
000082 SMITH, BECKY R 07-01-2004 1 - Active professional 1 - Active 0115 - BUSINESS MANAGER
F 2810 SNICKERS ROAD O 750 - BUSINESS 750 - BUSINESS
ANYWHERE TX 75661 17 o1 06-24-2022 100% 17 ! !
09-11-1952 17 1] 09-29-2004 116,000.00 1 9,666.67
000131 SMITH, BRENDA K 08-11-2005 2 - Active auillary per 1 - Active 0721 - CAFETERIA FULL TIME
F 5854 LIBERTY BELL RD O 735 - CAFETERIA T35 - CAFETERIA
ANYWHERE TX 758657 o 33 08-25-2022 100% CAF / i
01-24-1950 1]} 14 08-15-2006 15,346.80 3 14.21
000104 SMITH, CAROLYN M 08-09-2004 1 - Active professional 1 - Active 0638 - JR & SR HIGH TEACHER
F 42956 ROSEBEOROUGH RD O 002 - ANWHERE HIGH 002 - ANWHERE HIGH SCHOOL|
ANYWHERE TX 75672 18 [} 08-25-2022 100% 17 TR1 { 18/

o Personnel > Reports > Payroll Information Reports > HRS6550 - Employee Extra Duty
Report - The report lists all employees with extra duty codes on the Pay Info tab. The
report can be sorted by name, campus, or extra duty code. The Include Distribution
Account Codes parameter includes S-type distributions for the selected employees.

e J[ v [ o || sextens |

Payroll Information Reports HRSG550 - Employee Extra Duty Report

HRES13 m . it Listin:

HRS1450 - Employes Mai Labels

S 1650 - Ermplewes Salary Intorrmation
HRS52 04 Form:
HRSSIES - 1095-C Forms
HESE300 - Emploves Permit Data Inelude Distribution Account Cades? (1M
HES5350 - Emploves Responsibaity Data
HRSEA00 - Salary Verification Roport Pay Status Active (A}, Inactive (1), or blank for ALL
HESEAG0 - Health Insurance Coverage
HESES00 - Campys Intormation Pay Type L-4, Exclude Subs (E), or blank for ALL
HRS6550 - Employves Extra Duty R
HRSSE00 - Carmpus limmmovsient Pl‘iﬂé—nni YE Report Sclect Pay Campusies). or blank for ALL

HESE700 - Health Insurance Status Regort Select Primary Campus(es), or Blank for ALL : i

Parameter Description Value

Sort by Alpha [A). Pay Campus (), Primary Campus (P}, Extra Duty Code (E)

HRESE T AL 1 YTD Regort
Sclect Extra Duty Code(s). or blank for ALL

Sedect Efmnplayes{s), or blamk far ALL
Page Broak by Extra Duty Code (Y/N) (Reguined when selecting Sart by Extra Duty Coda)

Select Frequency
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Date Run: Employee Exira Duty Report Program: HRSG6550
Cnity Dist: ISD Page: 1of 8
Frequency: F
Extra Duty Code Typ Amount Remain Amt Remain Pymts
Emp Nbr Employse Name Account Code Job Acct Amit Acct Percent  Grant E Perf Pay Activity Code
000006 ACHIMON, AARON ROXANMNE 04 G 1.000.00 1] 0
000025 ALFORD, ADRIENNE JOHN 03 G 3.000.00 i} 0
04 G 1.000.00 ] 0
09 G 3.500.00 00 0
28 G 7.700.00 oo 0
42 G 1,000.00 ] 0
Total for ALFORD, ADRIENNE JOHN 16,200.00 .00

2. Update school calendar.
Create calendars
Personnel > Tables > Workday Calendars > School Calendar

Only complete this step if it is applicable to your LEA. All LEAs must create a TR calendar.

Selected Calenda Code: TR TR CALENDAR - Freguency: F
August F26 Septemiber 2026 October 2026 Movemnber 2026
Su Mo Tu We Th Fr Sa S0 Mo Tu We Th Fr Sa S0 Mo Tu We Th Fr Sa Sa Mo Tu We ™ F Sa
1 1 2 3 4 9 1 2 1 2 5 6 7 Workdays By Month
3 4 & 7 9 10 11 12 E &6 7 B8 9 iz 13 August 21
10 11 12 13 14 i Z 13 14 15 16 19 W0 ; [OE  September 2
17 18 19 20 21 2 0 71 23 % 27 Oictober ¥
3 24 % 26 27 28 2B 5 26 27 XB 29 30 Morammbssr 21
3 December 23
Tanwpary 21
December 2006 Janwary 2027 February 2027 March 2027 Fetruary u
Su Mo Tu We Th Fr Sa Su Mo Tu We Th Fr Sa Su Mo TuWe Th Fr_ Sa Su Mo Tu We Th Fr Sa g‘lh g:
1 2 3 4 1 2 1 2 3 4 S 1 2 3 4 5 May 7
8 9 10 11 1 3 4 &5 & 7 8 9 B 9% 10 11 12 3 B 8§ 0 11 12 (-5 23
13 14 1% 16 1v 18 19 W 11 12 13 14 1% 16 14 15 16 17 18 19 2 14 15 1& 17 18 19 July 73
0 21 22 23 24 25 16 17 1B 19 20 21 22 13 21 12 13 M IS5 26 2 13 M IS5 26
28 ¥ M 31 244 25 X I7 38 29 W 28 <8 9 30 31
Apeil 2027 May 2027 June 2027 Juty 2027
Su Mo Tu We Th Fr S3 Su Mo Tu We Th F Sa Su Mo Tu We Th A Sa S4 Mo Tu We Th F Sa Weekend 105
1 2 3 1 1 T 3 4 6 i 2 3 Kot Applicable 0
5 6 ? > 4 8 € A O 5 8 7 7 I Bad Weather Doy 0
12 13 G 0 11 12 13 14 15 16 17 18 19 3 14 Total Days 165
19 20 3 7 18 19 20 21 12 I3 24 2% g 21
26 27 0 24 25 6 27 IB 28 23 3D % 7 I8

Create school calendars to accommodate the varied number of days employees work at the
LEA. The calendar is used on the Payroll > Maintenance > Staff Job/Pay Data > Job Info tab to
calculate the Number of Days Employed field if the beginning and ending contract dates are
entered. Additionally, using a calendar can provide an easier way to manage payoffs and verify
your accrual days.

Notes:

o Calendars tied to a numeric frequency (e.g., 6) are used for current year.

o Calendars tied to an alpha frequency (e.g., F) are used for next year. Use the
spyglass to create or edit calendars as needed.

o You can copy calendars that begin in the same month. Example: If you create the
10-month calendar beginning in August for teachers for 187 days, you can copy the
calendar to the Food Service and Bus Driving calendar codes, and then edit them to
reflect the differences such as begin dates and holidays.

O Create calendars with the same calendar code as the current year to avoid having to update
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the calendar code on the individual employee's job info record.

O Select the calendar to be updated.

o F E [UBRARY AIDE/CAFE |
o F EE (BUzZBEE |
o] F F [caFETERIA ]
[o] F G [GIRLS HEAD BB COACH ]
D F H [BUS |
o] F I [careTeria MGR |
fo) F ) [VO AG AIDE ]
o] £ K [HouRLY |
o] F L [FRINCIPALS ]
fe] 3 M ) ]
o F n [MEDFORD |
D ¥ 0 [SUPERINTENDENT |
O F P [PEUGH ]
o] F Q [voac2 ]
o] F R [BUSINESS MANAGER |
o F S (ELem counseLor ]
o F s [SUMMER SCHOOL |
o F 55 [ suMMER scHooL J
o] F TR [TRcaLENDAR | .
Add
Start Year (YYYY) 2026 |

Start Month (MM) [08 |

Set Calendar «

Start Year |Type the starting calendar year in the YYYY format.
Start Month|Type the starting calendar month in the MM format (e.g., 07 for July).

O Click Set Calendar to display the calendar. The calendar is rearranged to begin with the
entered starting month.
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Selected Colendar Code: & TEACHER - Freguency: &
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3 4 & 6 7

Decenber 2025

Fr 53
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It is recommended that you build the calendar with the greatest number of days

IMPORTANT:

3. (Optional) Update accrual calendars.

worked first, and then use the Copy School Calendar tab to build other calendars
by making modifications to the original.

o For TRS purposes, a TR calendar with a calendar code of TR must be created
for all available workdays beginning 09/01. (TIP: If 9/01 falls on a weekend
day, select the first working day of the month.) The TR calendar is used to
populate the number of days worked on the RP report for employees who are
not assigned to a school calendar
o For TRS purposes, ASCENDER submits retirees' contract days one month at a
time. This allows maintenance on the reporting of half time or full time from
month to month on retirees.

(Optional) Update accrual calendars

Payroll > Tables > Accrual Calendars > Accrual Calendar

Log on to the next year pay frequency.

This step is for LEAs that perform monthly accruals.

Create accrual calendars to accommodate the varied number of days employees work at the
LEA. The calendar is used on the Payroll > Maintenance > Staff Job/Pay Data > Job Info tab to
calculate the Accrual Rate when the calendar code is entered in the Accrual Info section.
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Verify that the calendar code reflects the actual number of days the employee will work for the
new school year; otherwise, the salary amount that should accrue over the school year will be
incorrect.

o You can use the school calendar created in the previous step to get the actual workdays
by month.

o |If you have not set up the budget for the 2026-2027 school year, you can only enter pay
dates through the 2026 calendar year. If the budget is set up for the 2026-2027 school
year, you can enter 2027 pay dates in these fields.

Notes:

o This table can be updated after the move to current. All pay dates should be entered
even if zero days are accrued (e.g., summer months).

o Most districts only accrue 10-month employees. If that is true for you, each code
should begin with August 31 and show the number of days that group of employees
will work in August. Add 12 more lines and enter the true/regular Pay Dates. Enter the
days employees work in the month associated with each pay date.

o Typically, July and August (and sometimes June) will show the pay date and zero
days, but they still must be included.

o Dates used (with the exception of August 31) must match the Pay Dates that will be
built in the Pay Date Table.

4. Update staff credentials.
Update employee credentials
Log on to the current pay frequency.
Personnel > Tables > Credential

Update the Credential tabs as needed. This information is used to maintain teacher credentials,
is usually done by the personnel department and does not affect salary calculations.

The Credential tabs are shared between the current year and next year records; therefore,
changes to the current year records are effective in the next year records, and vice versa.
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Note: The Teaching Specialization tab is used to report Pre-K teachers for Class Roster so if
there have been changes, you can make those updates now in anticipation of the
submission.

MAJOR / MINOR COLLEGE CODE CERTIFICATION TYPE SPECIALTY AREA, TEACHING SPECIALIZATION SERVICE RECORD NOTES

[¢]

Personnel > Tables > Credential > Major/Minor

Personnel > Tables > Credential > College Code
Personnel > Tables > Credential > Certification Type
Personnel > Tables > Credential > Specialty Area
Personnel > Tables > Credential > Teaching Specialization
Personnel > Tables > Credential > Service Record Notes

o

o

[¢]

[¢]

[¢]

5. Update next year salary table.
Update next year salary tables
Personnel > Tables > Salaries NYR

Update the following next year salary tables to reflect any changes to the salary schedules
(anticipated or known).

These tables are not shared between the current year and next year records.

LOCAL ANNUAL HOURLY/DAILY EXTRA DUTY STATE MIN SUBSTITUTE MIDPOINT WORKERS' COMP

Personnel > Tables > Salaries NYR > Local Annual

This tab is the most commonly used. You can make mass updates by percent or dollar amount,
or by employee. To see a change before saving the record, enter the change and click Default.
The original annual amount is displayed in the Annual Amt column, the percent or dollar is
increased, and the New Amount is displayed. Click Save. If decreasing a salary, enter a
negative percent or dollar amount.

On the Personnel > Tables > Job/Contract > Job Codes tab, this salary concept can be attached
to the applicable job(s). When the job is selected on the Job Info tab, the system populates the
Base Annual field automatically in the Daily Rate section on that page and can calculate the
daily rate based on the number of days employed. In addition, when the Mass Update Salary
Calculations feature is used, the system uses this table to extract the correct salary information,
perform calculations, and populate many fields on the Job Info tab.
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Personnel > Tables > Salaries NYR > Hourly/Daily

The Hourly/Daily and Midpoint tabs can be updated in the same way if used by your LEA.
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Save
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Personnel > Tables > Salaries NYR > State Min
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This tab is updated via a file upload when applicable. These instructions are sent separately
with the file as needed.

Personnel > Tables > Salaries NYR > Substitute

This tab can be manually updated as needed.

LOCAL ANHUAL HOURLY DALY EXTRA DUTY STATE b SUBSTITUTE MIDPOINT WORKERS' COMP
s - i |
Delete b Ty Sub Descrgtion Tirs: Ting Degeription Lpdep Uity Sl Uinity Sl Pay Amg
" FEGULAR SUBSTITUTE [ A ] [FoLLcar [ ioe JH 10 | 000
| RECLILAR SUBSTITUTE [ B ] [ReFosr ] oo ) [ 5 ] 4500
o 3 DECRE DEGREED SUBSTITUTE [ A ] [:JLL DAY ] [ 1000 ] [ o ] 9500
(1! DEGREED SUBSTITUTE [ B ] [RaLF D ] [ om0 | | ] 4750
| CERTIFIED TEACHER SUBSTITUTE [ 2 ] [FuLoar ] [ 1ma | o ] 100,00
7] 03 CERTIF | CEFTIFIED TEACHER SUBSTITUTE B (Fair Dav ] o ) | 5 ) 50,00

Personnel > Tables > Salaries NYR > Midpoint

Payroll > Tables > Tax/Deductions > Workers' Comp

1. Update deduction code table.
Update deduction code table

Payroll > Tables > Tax/Deductions > Deduction Code

Year: C
EXEMPTIONS INCOME TAX FICA TAX UNEMPLOYMENT TRS RATES ANNUITY RATES WORKERS' COMP DEDUCTION CD
& [ADDTIONAL WITHHOLDING TAX )| [WH Additiv] [ADD-WITHHOLDING | D D [ 1| | | ] C]
[UraTED Wiy ] [WFunred »] (URTED WAY (] O | ] O
(1] [5avinGS BoNDS ] [s8saving+] [(SAviNGS BONDS | (] O [ ] :] :] O

O Update the deduction codes. The Deduction Code tab is shared between the current year and
next year records; therefore, changes to the current year records are effective in the next year
records, and vice versa.
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1. TRS Information
Verify TRS fields
Payroll > Reports > User Created Reports > HR Report

Generate a user-created report to verify that the following TRS fields are accurate for all
employees. You can use the sort/filter options to assist in the verification process. If corrections
are needed, use the corresponding pages to make changes.

TRS Reporting Requirements

o ALL employees are reported.
o Retired employees are only reported on the ER record.
o A contract Begin and End Date is required for ALL employees.

Required Information ASCENDER Business Page
The FTE Hours (full-time equivalent) is required for the |Personnel > Tables > Job/Contract >
ED record if 30 hours or more. Job Codes

The Days Worked or scheduled is required for the RP
record. This data is retrieved from either the school
calendar or TR calendar.

Personnel > Tables > Workday
Calendars

Personnel > Maintenance >
Employment Info

The TRS Status (TRS membership eligibility flag) is Payroll > Maintenance > Staff Job/Pay
required for the ED record. Data > Pay Info

A TRS Member Pos (position) Code is required for all
employees (including substitutes).

The Employment Type is required for the ED record.

Payroll > Maintenance > Staff Job/Pay

The WKkly Hrs. Sched (hours scheduled) is required for Data > Job Info

the RP record.

The Retiree Employment Type is required for the ER |Personnel > Maintenance >
record. Employment Info

2. Update staff data.

3. Update staff demographic data.
Update staff demographic data
Personnel > Maintenance > Staff Demo > Demographic

O Add new employees or update existing employees. Refer to the ASCENDER - New Employee
Setup guide for additional information about adding new employees.

The Staff Demo information is shared between the current year and next year records;
therefore, changes to the current year records are effective in the next year records and vice
versa.
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Employec: (00000 : ADAMS, ADEME. ] [ Retricve ] [ Directary ] [ 4ictel Eman ] [ Ciacumants ]

DEMOGRAPHIC INFORMATION CREDENTIALS WERIFICATION INSEURANCE SERVICE RECORD RESPONSIBILITY

Seaff IDVSSM:  110-26-2035 Tewas Unique Staff ID: [:] Last Change:  06-11-2008
Name
Legat [ W] [2DaM ] [E ] [eDams ][ ] ]
Masden Name
Farmer: [ V] [ ] [ ] [ ] [ V]
Titie First Mickdi= Last Generation
Addresses
Bsmber StreetPO. Box Apt City State Zip s
Mailing [ ] [Foeoxids ] [ ] [Alame Gry ] [T Teas NI | ]
Aliemate: [ ]I ] | ][ ~] |
Address Cosntry Dielivery Mame

Supplemental [ ] [ ] [ ]

Travel Commute Distance:

Remember: All employees must have a TX Unique ID number. The TX Unique ID number can
be extracted on the Personnel > Utilities > Texas Unique Staff ID Interface > Staff ID Export

tab.

STAFF ID EXPORT  STAFF ID IMPORT

School Year;

From: 2025 To:

Execute J

O Save the file and forward it to your District PEIMS Coordinator to be processed.

STAFF ID EXPORT STAFF ID IMPORT

Import File:

File Mame

[ mowse. | | Execue

2026/04/21 23:25 31 updated_payroll_nextyearpayrollprocess


https://help.ascendertx.com/business/lib/exe/detail.php/general/nypayrollprocess_staffdemo_step14.jpg?id=academy%3Aupdated_payroll_nextyearpayrollprocess
https://help.ascendertx.com/business/doku.php/personnel/utilities/texasuniquestaffidinterface/staffidexport
https://help.ascendertx.com/business/lib/exe/detail.php/general/nypayrollprocess_txuniqueid_export.jpg?id=academy%3Aupdated_payroll_nextyearpayrollprocess
https://help.ascendertx.com/business/lib/exe/detail.php/general/nypayrollprocess_txuniqueid_import.jpg?id=academy%3Aupdated_payroll_nextyearpayrollprocess

Business

4. Update employment info data.
Update employment info data
Personnel
Add or update employee information on the following tabs:

o Personnel > Maintenance > Employment Info - This tab is shared between the current
year and next year records; therefore, changes to the current year records are effective in
the next year records and vice versa.

O Select the NY Take Retiree Surcharge field to include the retiree surcharge when the
Extract Payroll to Budget process is performed.

Note: If service records have not been created, do not update data such as the
Percent Day Employed, Years Experience and Grade(s) Taught fields for
existing employees.

Terminated Employees

It is best practice to not only update the Termination Date and Reason but, if applicable,
update the Auxiliary Role ID and Paraprofessional Certification End Date.
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Save
Employee: (000001 : ] Retrie J [ Directory
EMPLOYMENT INFO
Employee Status: Mot Employed
Employiment Dites Emplayiment Types Retires Information
Original Emp Date: Employment VR ['F Half-Time or mare ~] Fetrement Data:
Latest Re-Empioy Date: Subs Typo: [ ) Retiree Employment Type: ( ~]
Termanation Duate: Highty Qualified: D Take Retinge Sunchange: D
Extract for TS0S D Year Roynd: D MY Take Retiree Surcharge: D
Termination Reason Extract I0: [ v]
Eligibde for Re-hire 0 Highest Degree:
i tc—
Percent Day Employed:
Pet Day Employed Effective Date: (7550 5000
Years Experierce Electromic Consent Service Record Contract Information Extended Leave
—Professicnal-- --Men-Prafessianal -- Wk [:] Full Semester: Class: [ ‘..] Begin
W pe gy o). | Eemanr Y | o ( 2 |
In District: D In Digtrict: ear: [ )
Price Teaching: @
Creditable Year of Service: D
TRA Years Experience Muiliary Role ID Paraprofessional Certification
TRA Teaching Experience: E
TRAE O Delete  Aspdliary Rele 1D Begin Date End Diate: Delete  Para Cert  Begin Date End Date
ligibility: - .
® 0 | e | — N e | e—

Personnel > Maintenance > Staff Demo > Responsibility

In addition, update the End Date on the employee's responsibility record.

2026/04/21 23:25

33

updated_payroll_nextyearpayrollprocess



https://help.ascendertx.com/business/lib/exe/detail.php/general/quickview/nextyearpayroll/personnel_employment_info_page.jpg?id=academy%3Aupdated_payroll_nextyearpayrollprocess
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/responsibility

Business

Save

Employee: Eﬂﬂﬂml 2

I

Directory J

DEMOGRAPHIC INFORMATION CREDENTAALS ~ WVERIFICATION

Delete  Details
o o

Year Campus Staff Classification Staff Service

Add

School Year for PEIMS Codes: 2026

INSURANCE SERVICE RECORD RESPONSIBILITY

lob Code: (0426 TEACHER'S AIDE v Staff Service: [SADDODO3 - Instructional Educational Aide |3
Campus: SPED Student Age Range: |01 Age 3 Through & (ot KG) v
Co-op/SSA LEA: :} Pop Served: (01 Regular Students v
Staff Classification: 033 - Educational Aide ]:  Monthly Minutes:
ESC/SSA: [School District Employee ~] # of Students: [I]

s O

| Enc Date: [05-18-2026] I
Payroll

o Pay Info - This tab is not shared between the current year and next year records.

O Make the necessary changes to the extra duty supplements and verify the changes
using the Payroll > Reports > Payroll Information Reports > HRS6400 - Salary Verification
Report.

O Updates to the extra duty table do not automatically update the extra duty data on the
Pay Info tab.

* Click Yes to update both the current year and next year records.
* Click No to update only the next year records.

This also occurs when changes are made in the current year records and next year
records exist.

o Job Info - This tab is not shared between the current year and next year records.

O For new employees, a generic job is displayed on the Job Info tab and this job can be
modified as needed. The following fields must be completed prior to saving:

* Primary Campus

* % Assigned

= # of Days Empld
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= TRS Member Position
= Begin Date
= End Date

Notes:

o The following data should be entered before performing automatic salary calculations:
* Pay Grade
= Step
» Sched (if applicable)
= Max Days
= State Step
= State Min Days
= TRS Year - This field should be selected if the employee has a nonstandard
contract.
* Accrual Codes
= W/C Code
= State Minimum Salary % Assigned - Verify this field for employees whose # of
Days Employed field does not match the State Min Days field on the Job Info tab
for the primary job and adjust accordingly.
= Distribution information
o Distributions - This tab is not shared between the current year and next year records.

O If a contract amount is not entered on the Job Info tab, no amount or percentage is
required before saving the record. If the account code does not exist in Budget, it cannot
be selected from the account code drop-down list.

O A distribution code must exist for each job to be updated with salary calculations. When
calculations are performed, amounts are updated based on the existing distribution

percentages.

O Verify Expense 373 designations for applicable employees who are subject to Stat Min
calculations.

o Deductions - This tab is not shared between the current year and next year records.

Exception: When changes to an existing employee's deduction information is saved, a
message is displayed asking if the current year records should be updated.

If the Remain Pymts field is set to 99, it will not decrement each time a payroll is
processed.

Be sure to add an Emplr Contrib (Employer Contribution) amount for vacancies/new
employees to avoid an understated budget.

Update the garnishment amounts as there may be changes to the salary amounts for the
upcoming year and the garnishment amounts are based on salary percentages.

Click Yes to update both the current year and next year records.
Click No to update only the next year records.
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This also occurs when changes are made in the current year records and next year
records exist.

* Click Yes to update both the current year and next year records.
* Click No to update only the current year records.

5. Perform salary calculations.
Mass update salary calculations
Log on to the next year pay frequency.
Payroll > Utilities > Mass Update > Salary Calculation

Perform salary calculations if you are using salary tables. This tab is used to automatically
calculate salaries for active employees (pay status 1) that are linked to the salary tables. You
can quickly calculate salaries and automatically update important fields in the employee record.

@i Otomton O v —
hd v
LR > hd | ~]
(2 ~] ] ‘1D ( =~
DECLCTIONS LEAVE EMPLOYEE EXTRA DUTY 108 CODE SALARY CALCULATION

TIP: Salary calculations should not be done multiple times for an employee using
& the midpoint table.

A report provides a listing of errors prior to completing the process. Clear all errors and perform
the calculations as often as necessary. All errors should be cleared before continuing. If
employee errors are encountered, the listed employees are not updated. If the employee has
multiple jobs and one of those jobs does not have all or part of the salary table information
selected on the Job Info tab, errors are displayed and updates are not processed. When
calculations are performed on one concept and the employee has multiple concepts, errors are
displayed if any of the other concepts are incomplete and updates are not processed.

The system automatically uses the new contract amount and distributes it among the
employees' master distribution records based on the existing percentage. The new amount
displays regardless of the option selected in the Distributions Built by Amt % field on the

2026/04/21 23:25 36 updated_payroll_nextyearpayrollprocess


https://help.ascendertx.com/business/doku.php/payroll/utilities/massupdate/salarycalculation
https://help.ascendertx.com/business/lib/exe/detail.php/general/nypayrollprocess_massupdate_salarycalculation.jpg?id=academy%3Aupdated_payroll_nextyearpayrollprocess

Business

Payroll or Personnel > Tables > District HR Options. Manual modifications may be necessary to
employees' salary distribution codes, amounts, and/or percentages after performing salary
calculations.

O The following fields must be completed on the Job Info tab for pay type 1, 2, and 3
employees:

o Pay Grade

o Step

o Max Days - If the Max Days field is not populated, salary calculations will only process if
the field is not linked to the Annual Salary Concept. If the field is linked to the Annual
Salary Concept, this field must be populated to run salary calculations.

o Begin Date

o End Date

o The OVTM Rate field and the # of Days Employed field are calculated when the OVTM
flag and Calendar Code fields are populated on the Job Info tab.

o If the State Step field is populated on the Job Info tab, the amount from the state
minimum salary table is entered in the State Min Salary field.

CAUTION: The State Min Salary field is calculated by multiplying either the

, State Min Days or the # of Days Employed by the appropriate daily rate from
the state minimum salary table for all pay types that have state min. The %
Assigned field in the State Info section on the Job Info tab is also considered in
this calculation. The State Min Salary field should be checked closely and
manually updated, if necessary, after performing salary calculations.

o If an employee has an extra duty account type G on the Pay Info tab, it is added to the
Total field for the contract on the primary job.

o If an employee has a business allowance account type T or B amount with remaining
payments and/or an extra duty account type S amount with remaining payments and
distribution codes totaling 100% exists in the master distribution record for the account
type, the appropriate distribution records are updated.

o If the # of Annual Payments and Contract Total fields are greater than zero, the Pay
Rate field is calculated by dividing the Contract Total by the # of Annual Payments.
If the # of Annual Payments and/or Contract Total are not populated, the Pay Rate is
not calculated.

o If the # of Days Empld and Contract Total fields are greater than zero, the Daily Rate
of Pay field is calculated by dividing the Contract Total by the # of Days Employed. If
the # of Days Employed and/or Contract Total are not populated, the Daily Rate of
Pay is not calculated.

o Other fields that are updated on the Job Info tab are:

= Accrual Rate - If the accrual code exists and the # of Days Empld and Contract
Total fields are greater than zero, the Accrual Rate field is calculated by dividing
the Contract Total by the # of Days Employed. The amount is rounded to three
decimal places.
= Contract Total and Balance
¢ Pay type 3 employee salaries are calculated based on the hourly/daily or
midpoint salary table information. If the local annual table is used, errors are
displayed when performing mass salary calculations.
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e When using the hourly/daily salary schedule, calculations are based on the
Hrs Per Day field x the Amount field from the salary table x the # of Days
Employed field from the Job Info tab. The resulting amount populates the
Contract Total and Balance fields on the Job Info tab.

e When using the midpoint salary schedule, calculations are based on the
Midpoint field x the Amount field from the salary table x the # of Days
Employed field from the Job Info tab. The resulting amount populates the
Contract Total and Balance fields on the Job Info tab.

e |f the # of Days Employed field is not populated, the Contract Total and
Balance fields are not calculated.

o If not performing mass salary calculations for hourly employees, manually update the
Contract Total on the Job Info tab and distribution information. This salary information is
extracted to Budget and used for PEIMS reporting.

o On the Job Info tab, there is a Calculate button, salary calculations can be done for an
individual rather than doing salary calculations in Mass Update for groups of employees.
The Calculate button on the Job Info tab will render the same results as doing the Mass
Update salary calculations.

o The Automatically Compute fields on the District HR Options page assist in manually
updating employees. By using this feature, the pay rate, daily rate, dock rate, accrual
rate, and overtime rate can all be automatically calculated when the annual contract and
days employed are entered on the Job Info tab.

Midpoint Calculation Examples

- ¢ : 2 Max Percent Fay Mid Percent Pa Max Inc/Dec Mid Inc/Diac
Pay Grade Pay Type Minimum  Maximum  Midpoint ¥ ¥ Hour
Increase Increase Amount Amount

1 Contracted employes 203.680 305.530 254 605 [

2 _"J_I] 0.000 5.092 2.00

) |
1 Contracted emploves 224040 336070 280055 | 0000) | 2000) 0.000 6601 B.00

6. Verify salary calculations.
Verify salary calculations
Select and run the applicable reports to verify the salary calculations:

o Personnel > Reports > Personnel Reports > HRS1000 - Roster of Personnel - This report
provides a list of employees by pay campus. This is a good report to give to principals and
directors to verify employees assigned to their campus or department without sharing
pay information.

o Payroll or Personnel > Reports > Personnel Reports > HRS1250 - Employee Data Listing -
This report provides detailed information about demographics, salary,
TRS/Calendar/School YTD, leave, deductions, and account distribution codes.

o Payroll > Reports > Payroll Information Reports > HRS6050 - Contract Balance Variance
Report - This report will print exceptions for contracted (pay type 1) and non-contract
(pay type 2) employees when the contract balance does not equal the Pay Rate times
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the # of Remaining Payments.

o Payroll > Reports > Payroll Information Reports > HRS6150 - Employee Payroll Listing -
This report provides detailed information about pay status, campus code, pay type,
marital status, number exemptions, months/days in contract, annual contract amount,
monthly/daily rate of pay, and the first distribution line from the master distribution
record.

o Payroll > Reports > Payroll Information Reports > HRS6400 - Salary Verification Report -
This report can be used to verify that next year salary calculations have been correctly
run before copying next year to current year.

o Payroll > Reports > Payroll Information Reports > HRS6000 - Account Code Comparison -
The report is an error listing. For current year, the report identifies account codes in the
payroll process and verifies that these account codes exist in Finance. If a code entered in
the payroll process is not located in the chart of accounts, the account number, social
security number, and name of the employee are printed on the report. For next year, the
report identifies account codes on the Budget Data page of the Budget application.

o Personnel > Reports > Payroll Information Reports > HRS6550 - Employee Extra Duty
Report - The report lists all employees with extra duty codes on the Pay Info tab. Users
can sort the listing by name, campus, or extra duty code. The Include Distribution
Account Codes parameter allows the user to include S-type distributions for those
employees selected.

o Payroll or Personnel > Reports > Payroll Information Reports > HRS6650 - CYR/NRY Salary
Comparison - This report provides a salary comparison for employees with pay type 1 and
pay type 2 jobs. The report indicates employee information and job information for both
the current year and next year to allow an easy comparison of salaries between the data.

o Payroll or Personnel > Reports > User Created Reports > HR Report - Run user created
reports as defined by the user.

7. Use Addendum sheets to verify data.
Use Addendum sheets to verify data

Payroll > Utilities > Payroll Simulation > Addendum

Use the Addendum created when using the Payroll Simulation utility to verify data as it lists all
jobs separately, as well as business allowances, extra duty, etc.

Only active employees (pay status 1) are considered in this process. The Addendum sheets can
be used to explain pay to employees and as a contract support document for applicable
employees to sign & date.

Personnel > Reports > Payroll Information Reports > Employee Salary Information
o If this report is generated from next year payroll files, leave information is excluded.
o If this report is generated from current year payroll files, leave information is included.
8. Perform a "test payroll".
Perform "test payroll"

Log on to the next year pay frequency.
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Payroll > Utilities > Pre-Edit Payroll Data

Run this utility to perform what could be called a “test payroll” for employees that meet the
selected parameters.

It is a partial run of calculations and it does not use transmittals or leave files. This utility can be
run in either the current year or next year.

An unprocessed pay date is required to be entered. If there are no unprocessed pay dates in the
Pay Dates table, enter a pay date for the next month. For example, August payroll has been
processed and pay dates for the new school year have not been entered yet.

Note: This utility should be run prior to creating your budget extract or before copying the
next year to the current year. This utility creates a report that displays errors on each
employee. The report is sorted by employee number order and provides error messages
that are easy to understand so that corrections can be made prior to extracting for budget.
Remember, if changes are made to the employee records, calculations need to be run
again.

9. Extract payroll account codes.
Extract payroll account codes

Payroll > Next Year > Interface NY Payroll to NY Budget > Extract Payroll Account Codes

Before interfacing the payroll to the budget, verify the following:

o Are all new employees in the system?

o Are all employees active that are to be extracted to budget?

o Are all Staff/Job Pay data tabs updated and complete for new and existing employees?

o Does the next fiscal year in distributions match the budget fiscal year?

o Are all deductions updated?

o Are all extra duty stipends updated?

o Since the next year payroll budget calculations use the s-type extra duty remaining
amounts, verify that these amounts have been updated.

Run this utility to extract payroll account codes for specific active (pay status 1) employees who
are in the next year payroll. The resulting extract is used to transfer this information to the
budget. This process can be repeated as often as necessary.
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O If applicable, select Exclude TRS On-Behalf Calculations.

O If you interface the on-behalf expenditures (6144) into Budget, manually input the revenue
for the on-behalf account codes (5831).

10. Verify the Extract Reports tab.
Verify Extract Reports tab
Payroll > Next Year > Interface NY Payroll to NY Budget > Extract Reports

Use the reports to verify the accuracy and validity of the employees, accounts, and amounts.

Wi M Fragusney: F

EXTRALT PAYROLL ACCOUNT ODDES EXTRACT REPORTS  INTERFACE TO BUDGET

Mgut Vigar Payeoll Extract Reports

Gen RApt Reepet, St Oipions Sort Orer
D Hawt Year Payrell brployes Dainbeton  Alpha (&), Pay Camggs [C). Primary Campus [F) EI
0 Harct Yesr Bayrall A t Defribnatnr Eund [F1. Organiration [0 I:l

Pay special attention to the employee count to verify that the correct number of employees are
extracted and match the count on the Next Year Payroll Employee Distribution Report.
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Date Run: Mext Year Payroll Account Distribution Program: HRS9970
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Sort Order: Fund
Account Code Amount
199-11-6119.00-001-611000 TEACHER SALARIES, GEN INSTRUCT
E 000443 22.112.86
E 000461 13.142.50
F 000450 3205415
£ 000459 20.050.00
E 000462 33.298.50
F 000372 26.771.50
E 000435 41.090.34
F 000452 2.000.01
E 000445 875.00
F 000460 750.00
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199-11-6119.00-001-622000 PROFESSIONAL SALARIES
E 000443 268415
F 000452 500.01
E 000445 61.498.34

11. (If necessary) Perform another extract and interface to Budget.

(If necessary) Perform another extract and interface to Budget

If changes are made to employee salary information, employees are added, employees are
inactivated, or termination dates are entered, perform another extract and interface those new
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changes to Budget.

Note: Updates to the budget will replace the existing amounts for those account
distribution codes that match the accounts in Budget. If an account distribution code no
longer exists in payroll when interfaced to Budget (after previous interfaces), the account
code is not changed or removed in Budget. You must manually modify the budget for those
account codes. This also applies to those amounts in the budget that have been manually
modified after the initial interface from payroll. If the budget account is not locked and the
change needs to be retained for budget purposes, all manual modifications need to be
made again.

12. Interface to Budget.
Interface to Budget

Payroll > Next Year > Interface NY Payroll to NY Budget > Interface to Budget

EXTRACT PAYROLL ACCOUNT CODES EXTRACT REPORTS INTERFACE TO BUDGET

Meact Year Payroll Round acocount totals to the nearest dollar
D Use Budget Crosswalk tables

@ Mext ¥r Recommend

(O Mext ¥r Approved

If all of the information is correct:
O Under Next Year Payroll, select one of the following columns to be updated in Budget:

o Next Yr Recommend
o Next Yr Approved

O Click Interface. This process can be repeated as often as necessary until the Board approves
the budget. For each run, the Next Year Budget amount is replaced. If the budget lock flag is
set on an account, the budget amount is not replaced.

If distributions or employees are changed after the first calculations are interfaced, you
may be required to log back on to the current pay frequency and use the Payroll > Next
Year > Copy CYR Tables to NYR > Clear Next Year Tables tab with the Clear NY Payroll
Budget Only option selected to recalculate and interface the new changes back to the
next year frequency.

Contact your regional ESC consultant if you need additional assistance.
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13. Perform staff benefits update.
Perform staff benefits update
Log on to the next year pay frequency.
Payroll > Utilities > Employee Benefits Interface > Import Annual File

Perform the employee benefits update and import process.
Year: & Frequency: F
EXTRALT IMPOAT ANMUAL FLE IMPORT CHANGES OMNLY

ear Selection

O Under Year Selection, select one of the following:

o Current Year

o Next Year
Active Employees |Select to base the selected pay frequency for the records on the
Only highest pay frequency in which the employee is active.
Deduction Import [Click Browse, and then select the folder to which a copy of the
Path deductions is to be imported. Click OK to select the folder or Cancel to
close the dialog box without processing.

O Click Execute to start the import process.

o In the application dialog box, verify the path of the import, and click Yes to continue the
import or No to return to the import dialog box.

o In the archive password dialog box, type a password for this imported file. Click OK.

o The files are imported, and a message is displayed indicating the import process
completed successfully. Click OK.

If any errors are encountered during the import process, an error report is displayed. If there
are no errors, the error report is not displayed.

If no errors are encountered during the import process, or you clicked Continue from the error
report, the import report is displayed.

Review the report.
O Click Continue to proceed.

O If you click Process, a message is displayed indicating that the data was imported. Click OK.
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